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What is Workshare Professional

Workshare Professional reimagines multi-party review and collaboration and ensures the
safe and accurate exchange of information, enabling the collaborative evolution of high
value business documents.

Workshare Professional is a desktop application that automates managing changes to
business documents, protects against unauthorized content disclosure and delivers the
world’s most secure PDF creation, all in one integrated solution.

Key features of Workshare Professional include:

Comparison of Word, PowerPoint, Excel and PDF files, including image-based
PDF files

Comparison of selected pieces of content, such as a single paragraph or clause
Ability to accept/reject in a comparison and then create new documents

Advanced comparison features including one-to-many comparisons (Word and
PDF files), version comparisons, and access from within Office and Document
Management Systems

Access to comparison functionality from within Outlook as well as right-click access
from within individual emails

Conversion from PDF to DOC format for local files and from within the DMS/CRM

Advanced, interactive metadata cleaning/PDF creation/secure file transfer for
attachments in Outlook

Comprehensive content risk protection enabling the discovery and removal of
hidden sensitive data as well as visible sensitive data

Options to save and share Office documents to Workshare online
Access and visibility into online collaborative workspaces directly from Office

Secure file sharing from all devices and browsers with metadata removal and end-
to-end encryption

Centralized policy design and enforcement administrator tools
ECM/DMS and OCR integration with desktop comparison features
Centralized user account management and control

Complete access to Workshare online functionality to share and collaborate on
documents, including setting folder access and permissions, positional commenting
and reviewer communications with presence indicators

Desktop sync app to synchronize your online content to your local desktop
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Note: Workshare Professional can be installed without Microsoft Office integration. In this
case, the comparison functionality is only available from the Workshare comparison
applications and the metadata removal functionality is only available when sending
emails.

What’s New in Workshare Professional 10.2

The Professional 10.2 Revision 1 release includes the following:

e Onboarding in Compare for Excel

The first time a user runs a comparison in Compare for Excel, they will be shown a
useful onboarding wizard to explain how to view changes and navigate in the

comparison.
_

Welcome to your comparison

The changes between your selected spreadsheets are highlighted in >
different colours.

® O OO

e Comparison improvements in Compare for Excel.

o Assorted bug fixes.

System Requirements

The recommended system requirements for Workshare Professional 10.2 Revision 1 are:
o Intel Core i3 @ 2.5GHz
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e AMD Athlon 64 X4
* 4GB RAM

Workshare Professional 10.2 has a 32-bit version for 32-bit Microsoft Office environments
and a 64-bit version for 64-bit Office environments.

Certified Environments for Workshare Professional 10.2
(32-bit version)

Workshare Professional 10.2 Revision 1 (32-bit version) has been tested and certified in a
number of environments. If your environment is not included in the following list, it may still
be a compatible environment. Contact Workshare Customer Support
(support@workshare.com) for any help.

For details of which environments previous versions of Workshare Professional/Compare/
Protect were certified against, refer to previous versions of release notes on the
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us
language set.

Operating System:

e Microsoft Windows 10 (32 bit and 64 bit)

e Microsoft Windows 8.1 (32 bit and 64 bit) + Japanese

e Microsoft Windows 7 SP1 (32 bit and 64 bit) + Chinese Simplified & French
Citrix:

o With Microsoft Windows Server 2012 R2 or 2016 (64 bit)

o Citrix XenApp 7.5
o Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports
your version of Citrix.

Microsoft Office System:

e Microsoft Office 365 (desktop)

e Microsoft Office 2019 (32 bit) — including click-to-run

o Microsoft Office 2016 (32 bit) — including click-to-run

o Microsoft Office 2013 SP1 (32 bit) + Japanese — including click-to-run
Email System:

e Microsoft Outlook 365 (desktop)



mailto:support@workshare.com

Workshare Professional 10.2 Release Notes

e Microsoft Outlook 2019 (32 bit)

e Microsoft Outlook 2016 (32 bit)

e Microsoft Outlook 2013 SP1 (32 bit) + Japanese
e IBM Notes 9.0.1 FP7, FP8 and FP9

Note: Interactive Protect and the replace email attachment with link features of
Workshare are not supported in a Notes environment.

Browsers:
o Microsoft Edge, latest version
e Microsoft Internet Explorer 11
o Google Chrome, latest version
e Mozilla Firefox, latest version
Microsoft SharePoint:
e Microsoft SharePoint 2013 SP1

DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports
your DMS.

e NetDocuments
ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send
to application functionality, Microsoft Internet Explorer must be installed
(although it does not have to be the default browser).

« iManage clients:
o FileSite/DeskSite 9.0 Update 6 and above
= Work 10 Desktop for Windows 10.0 and above

= Work 10 web client (You will need to install Workshare iManage Integration
Server in order to launch comparisons from the iManage browser interface.)

Note: If you use a Work 10.2 server, it must include iManage Work Web Server
10.2.0.91 (which can be requested from iManage with reference CSAR-2673).

o OpenText:
= eDOCS DM 16.5
= eDOCS DM 10
o eDOCS DM 5.3.1 COM only (Patch 6)
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o Worldox:
= GX4

Workshare will endeavor to support future service packs of certified environments.

Certified Environments for Workshare Professional 10.2
(64-bit version)

Workshare Professional 10.2 Revision 1 (64-bit version) has been tested and certified in a
number of environments. If your environment is not included in the following list, it may still
be a compatible environment. Contact Workshare Customer Support
(support@workshare.com) for any help.

For details of which environments previous versions of Workshare Professional/
Compare/Protect were certified against, refer to previous versions of release notes on the
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us
language set.

Operating System:
e Microsoft Windows 10 (64 bit)
Citrix:
o  With Microsoft Windows Server 2012 R2 (64 bit)

o Citrix XenApp 7.5
o Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports
your version of Citrix.

Microsoft Office System:
o Microsoft Office 365 (desktop) (64 bit)
e Microsoft Office 2019 (64 bit)
e Microsoft Office 2016 (64 bit)
o Microsoft Office 2013 SP1 (64 bit)

Email System:

o Microsoft Outlook 365 (desktop) (64 bit)
e Microsoft Outlook 2019 (64 bit)
e Microsoft Outlook 2016 (64 bit)

e Microsoft Outlook 2013 SP1 (64 bit)
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Browsers:
o Microsoft Edge, latest version

e Microsoft Internet Explorer 11
o Google Chrome, latest version

e Mozilla Firefox, latest version

DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports
your DMS.

e NetDocuments
ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send
to application functionality, Microsoft Internet Explorer must be installed
(although it does not have to be the default browser).

« iManage clients:
= FileSite/DeskSite 9.3 (64 bit) and above
o Work 10 Desktop for Windows 10.0 (64 bit) and above

= Work 10 web client (You will need to install Workshare iManage Integration
Server in order to launch comparisons from the iManage browser interface.)

Note: If you use a Work 10.2 server, it must include iManage Work Web Server
10.2.0.91 (which can be requested from iManage with reference CSAR-2673).

o OpenText:
= eDOCS DM 16.5
= eDOCS DM 10

Workshare will endeavor to support future service packs of certified environments.

Important Information

Secure PDFs — Workshare Professional is unable to compare secure PDFs or convert
secure PDFs to Word format. Secure PDFs are PDF files with security settings configured.

POP/IMAP — Workshare Professional does not support Outlook when it is configured with
a POP or IMAP account.
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Important installation information

o Workshare Professional installs program files to a sub-folder within the Workshare

folder named Modules.

o Install: A user is unable to install Workshare Professional if Microsoft Windows
Installer 3.1 is not installed. This can be downloaded from the following location
https://www.microsoft.com/en-us/download/details.aspx?id=25.

e Windows 7: When UAC is set to Default, running the Workshare Professional
install displays the UAC prompt. You must approve the prompt and Workshare
Professional will be installed. Running the Workshare Professional MSI silently will
fail when UAC is set to Default because the user is not given the opportunity to
approve the UAC prompt. Therefore for silent installs, disable UAC.

If you have installed any Alpha or Beta builds of Workshare Professional, we strongly
recommend that you first uninstall them before installing Workshare Professional 10.

Change Requests Fixed

The following are fixed customer change requests that have been validated for this release
- for more information, please contact Customer Support.

Ref
PRO-2134

PRO-3063

PRO-3318

PRO-3405

PRO-3570

PRO-3698

PRO-3754

PRO-3805

CR
01161107

01166236

01167611

01171971

Description

Comparison printed incorrectly from TER view when
comparing documents with Unicode characters

Quotation marks are shifted slightly to the right and overlap
the character slightly when saving or printing to PDF

Workshare Compare crashes when comparing from
Selective Compare for the second instance of Compare

The Option "Allow Redline to be versioned to
Modified/Original documents" does not work when saving to
iManage Work 10

Compare for PowerPoint application crashes when
performing 'Print' action after selecting any of the printer
options

Compare for PowerPoint application process does not
terminate after shut down

Compare for Excel is not launching when FIPS Algorithm is
enabled in GPO

Changes to document not being detected in Compare when
using certain workflow
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Ref CR Description

PRO-4010 'Overwrite existing file' message dialog is displayed on trying
to save a PPT redline to DMS with an existing filename in
.PDF format.

PRO-2774 | 01164185 Error message: 'The comparison couldn't be performed’
when comparing specific Excel documents

PRO-2775 | 01164232 Error message: 'The comparison couldn't be performed...Try
running a comparison with other files' occurs when
comparing specific Excel documents

PRO-3034 | 01165736 Word document saved in .doc format and using Number List
formatting results in incorrect changes being display in TER

PRO-3254 | 01167763 Compare for Excel produces error "The comparison couldn't
be performed" when comparing certain spreadsheets

PRO-3476 | 01168878 Comparison of certain Excel spreadsheets fails with
message of "The comparison couldn't be performed"

PRO-3543 | 01169502 Ability to save comparison as Related file when integrated to
iManage Work 10

PRO-3699 Saved PowerPoint Comparison name is not populated with
name provided when saving PPT comparison in PDF format

PRO-3708 | 01170207 Bullets do not show correctly when compared with Fast
Mode

PRO-3733 Opentext eDocs DM : Object has been deleted' message is
displayed when comparison is performed from 'Selective
Compare'

PRO-3759 | 01170952 Error: Workshare 10.0 was unable to retrieve the
Original/Modified source document when selecting
documents from a particular iManage database

PRO-3767 Excel comparison automatically launched incorrectly has a
temp file name

PRO-3791 01171854 Numbering is incorrectly detected as inserted/deleted, and
only the deleted numbering shows in TER view when
comparing specific documents

PRO-3792 | 01171784 iManage Dialog Box Appears behind Desktop App when
Uploading a File through the Desktop App

PRO-3801 Track change document name is appended with .pdf after
saving as a PDF

PRO-3982 | 01173788 Blank email created in 'Drafts' folder when Interactive

Protect is enabled
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Ref CR Description

PRO-1350/ | 01143410 "Workshare 9 was unable to retrieve the original/Modified

PRO-3957 source document." when comparing PDF documents from
an email

PRO-2811 01164461 Compare for Excel fails when comparing the attached XLSX
files

PRO-3732 | 01170777 Comparing specific documents causes incorrect/misleading

results in TER view and when saving comparison

Known Issues

The following are known issues in the Workshare Professional 10.2 Revision 1 release -
for more information, please contact Customer Support.

Ref Description
PRO-4049 = A .NET framework error occurs when launching Outlook if Workshare
01173819 | Professional is not licensed.
PRO-3753  Unable to select certain cells after running Excel comparison.
01170892
PRO-3449 The error "System.Threading.ThreadAbortException" may be displayed
01168494 @ When saving a redline as attach/relate to original/modified document in
OpenText DM 16.5.
iManage integration: After an upgrade, the recent files list in Compare’s
PRO-3409 Document Selection dialog retains the recent files compared prior to the
01168025 upgrade. However, you are not able to compare those recent iManage files
because the path is shown as “interwovenSite://...” rather than
“iManage://...”.
PRO-3137 | When cleaning metadata from a PowerPoint attachment with the lightspeed
01166593 | clean option enabled, the slide animation sequence may be removed.
PRO-2609 . . ,
01163333 Links in Excel documents are detected again even after removal.
Errors can occur when using Selective Compare if Compare dialogs are
PRO-2513 open and the "Launch new comparison in running instance" configuration
option is enabled.
PRO-2342 Replies to comments in Word are detached when the lightspeed clean
01161036 | option is enabled.
PRO-1387 @ Compare for Excel: Changes may not be indicated correctly when

comparing spreadsheets with a deleted/inserted column when the first row is
empty.

11



Ref
PRO-1386

PRO-1019

PRO-837
01061816

PRO-815
01062255

PRO-792
01088791

PRO-528

PRO-527

PRO-525

PRO-109

01099537

PRO-22

01012100

01018577

01018743

01028440

40418
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Description

Compare for Excel: Merged cells are displayed as individual cells when the
merged cell is not in full view on the comparison window.

Compare for Excel: Focus is not completely applied to the last change in the
comparison window if the user clicks the Last Change button for the first
time.

After running a comparison in Workshare Compare, the right aligned text in
the footer may move to become center-aligned.

Combine PDF is not picking up changes made to an open iManage
document even after saving it. The workaround is to close the saved
document and reopen it before using the Combine PDF functionality.

After running a comparison in Workshare Compare, some line numbering
and table text and row cells maybe be missing.

IBM Notes 9.0.1 FP7 only. Attachments are duplicated in sent items when
the email is processed through desktop profiles or all mail profiles. This is an
issue with IBM Notes.

IBM Notes only. Attachments are not automatically compressed to a zip file
when the limit specified in the WCM is reached.

The positioning of signature components in RTF format emails can be
incorrect after processing with Protect.

The error ‘Failed to compare documents. Unable to convert documents.’ is
displayed when comparing specific scanned PDF documents.

The Reset Layout option is missing from the Quick Access Toolbar
drop-down in Compare for PowerPoint.

The account or company name is not displayed in File > Help > About in
Workshare Compare.

Worldox document footer stamps are not updated when saving a
comparison via Save As in Workshare Compare.

The font in the email body changes to Times New Roman when sending
attachments to groups in Interactive Protect.

Editing a rendering set on the fly does not prompt to save as a new set or
overwrite the current rendering set.

When comparing particular presentations, 'Index was outside the bounds of
the array' error is displayed.
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Ref Description

40430 When comparing presentations and at least one has the Opulent design
theme applied, a ‘Color is not resolved yet’ error is displayed.

40469 In Compare for PowerPoint, a newly created comparison theme does not
appear in the Select dropdown in the Home ribbon (Comparison Themes
group).

40574 A user is not automatically logged into Professional after logging into the
desktop app first (64-bit version only).

40597 The local file store dialog is displayed when browsing for files from the
desktop app when a DMS is set as the default (64-bit version only).

41284 In Compare for PowerPoint, comparisons of DMS files are not listed in the
recent comparison list (File > Open > Recent).

41547 When a PowerPoint presentation is run from the command line, the incorrect
comparison theme is highlighted under the Select dropdown in the Home
ribbon.

45583 When a machine is restarted before the convert to link process has

completed, files which are not synced are moved to a conflict state in the
desktop app.

Contact Info

For technical help and support on Workshare products, contact Workshare Customer

Support:

support@workshare.com
EMEA: +44 207 539 1400
US: +1 415 590 7705

For sales enquiries, contact the Workshare Sales team:

sales@workshare.com
EMEA: +44 207 426 0000
US: +1 415 590 7700
APAC: +61 2 8220 8090
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& Workshare Ltd.
© 2019. Workshare Ltd. All rights reserved.

Copyright

Workshare Professional and Workshare DeltaView are registered trademarks of Workshare Ltd. Workshare Compare,
Workshare Protect, Workshare 3, Workshare DeltaServer, SafetyGain, and the Workshare logo are trademarks of
Workshare Ltd. All other trademarks are those of their respective holders.

Trademarked names may appear throughout this guide. Instead of listing these here or inserting numerous trademark
symbols, Workshare wishes to state categorically that no infringement of intellectual or other copyright is intended and
that trademarks are used only for editorial purposes.

Disclaimer

The authors/publishers of this guide and any associated help material have used their best efforts to ensure accuracy
and effectiveness. Due to the continuing nature of software development, it may be necessary to distribute updated help
from time to time. The authors would like to assure users of their continued best efforts in supplying the most effective
help material possible.

The authors/publishers, however, make no warranty of any kind, expressed or implied, with regard to Workshare
programs or help material associated with them, including this guide. The authors/publishers shall not be liable in the
event of incidental or consequential damages in connection with, or arising out of, the programs or associated help
instructions.

For details of Workshare patents, see www.workshare.com/patents

Revisions

Published for Workshare Professional 10.0: 18/12/18; minor revisions: 17/1/19 & 15/2/19
Revised for Workshare Professional 10.1: 27/3/19

Revised for Workshare Professional 10.1 Revision 1: 16/5/19

Revised for Workshare Professional 10.2: 28/6/19

Revised for Workshare Professional 10.2 Revision 1: 19/8/19

Workshare Ltd., 20 Fashion Street, London E1 6PX www.workshare.com
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